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Prepare Inventor models to be sent to Alias for conceptual design 

Why Alias? 

Alias Design allows a designer to address the mechanical functionality of a design as well as, meet the 

creative requirements in a seamless workflow.  It is where CAID (Computer Aided Industrial Design) 

meets CAD (Computer Aided Design).  

Check Out That File! 

To try and make this workflow as accurate as possible we are under the assumption that our design is in 

the Vault.  We will start out by opening the file up from Vault and checking it out through Inventor.  

After we are finished making the required modifications to the file, we will check it back in so it can be 

used in Alias Design.  This workflow is required for when you have predefined constraints and or 

parameters that must be considered for while working within Alias Design. 

Ok, how can I prepare my Inventor models for Alias Design? 

There are a couple different methodologies that one can take in preparing a model in Inventor for Alias 

Design.  Since the main focus of this class is Alias Design, some instructions/details may be omitted.  

Please take the time and explore the full potential of the below commands. 

1. Copy Object – the idea for this is to copy the required surfaces from a “part file” and reference 

them in a derived part to be brought into Alias Design. 
a. Start the “Copy Object” command within the “part environment” and select only the 

required faces to be transitioned into Alias Design.   
b. Right click on the newly created surface in the model browser and select “Export 

Object”.  We do this so that when we create the derived part we can reference in those 

surfaces. 
c. Create a new part file and start the “Derive” command.  Select the source file and then 

select the surface(s) to be derived.   
d. Save and check this file into the Vault.  You may want to give it a name that is based off 

the original file with “Alias” attached to the end (LE Frame – Alias.ipt).   
2. Do nothing!  Alias can handle referencing in the entire Inventor assembly or part file.  Since our 

goal is to eventually bring the model back into Inventor, importing the entire model from 
Inventor may be overkill depending on how complex your Inventor design is. 

3.  Level of Detail (LOD) – potentially the most common workflow will be when the requirement is 
that you must digitally sculpt around multiple parts of an assembly.  As mentioned before large 
complex models may be overkill. So a way of combatting this issue is to use a LOD.  Listed below 
are three different ways LOD’s can be used. 

a. Within the “assembly environment” right click on the LOD node in the model browser 
and select “New Level of Detail”.  Here we will suppress the entities that are not 
required for Alias Design.   
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i. Give it a name. 
ii. With a combination of using one of the many selecting techniques (shift + right 

click) or just manually selecting parts and sub-assemblies and suppressing them. 
Continue this workflow until you have the desired result of only the necessary 
components needed for Alias Design. 

iii. Set this LOD to be current before bringing into Alias Design. (Alias will bring in 
whatever the current state of the Inventor file is set to.) 

b. Within the “assembly environment” right click on the LOD node in the model browser 
and select “New Substitute - Derived assembly”.  This will basically convert the assembly 
into a single part file. 

i. Give it a name. 
ii. Within the dialog box adjust the settings as necessary.  Since Alias Design is 

primarily a surfacing program, you may want to select the surface option. 
iii. Do not forget to explore the rest of this dialog box especially the “Options” tab.   

c. Within the “assembly environment” right click on the LOD node in the model browser 
and select “New Substitute - Shrinkwrap”.  Shrinkwrap uses the derived component 
command in the background with some added functionalities. 

i. Give it a name. 
ii. Within the dialog box adjust the settings as necessary.  Since Alias Design is 

primarily a surfacing program you may want to select the surface option. 
iii. Since this is not a live update after making changes in the dialog box select the 

“Preview” button to regenerate the model to see the results. 
4. What say you?  There is no right or wrong way to do this as long as you are getting the required 

information from Inventor into Alias Design.  You may even choose to create a “dummy” 
assembly with just the components needed, or a part that is based off of the assembly file 
(create component command in the assembly environment).   

Be creative, experiment with different methodologies until you find one that creates your desired result.  
No matter how you go about achieving the file to be used in Alias Design, do not forget to check it into 
the Vault.  Also, keep in mind that if you choose to use the LOD method, make sure the target LOD is the 
active one when checking into Vault, because that is what Alias Design will read in. 

  

Use Alias at a beginner level to develop real world designs 

First Things First – The User Interface (UI) 

In my experience, the most effective way for new users/students to digest learning new software is for 

them to have a solid understanding of the UI before we click on any buttons.   Therefore, let’s break 

down the UI into its main components in no particular order. 
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1. Menu Bar – The menu bar contains a series of pull-down menus.  Each menu contains a group of 

related commands.

 
2. Layer Bar – The layers bar is used to create and manage layers.  Layers are basically containers 

for which objects get assigned by the user.  Think of how you would use layers in AutoCAD.  

Much like AutoCAD’s layer 0, Alias has a layer that cannot be deleted which is called “Default 

Layer”.  My preference is to avoid assigning items to that layer. 

 
3. Shelves – Shelves are a customizable area where you can place commands that are common to 

your workflow.  It is the equivalent of creating a custom panel within Inventor or AutoCAD.  I 

recommend closing the default shelf, which includes some generic commands, until you have 

some experience under your belt in deciding on which commands you want there.  Think about 

it, on day one with Inventor could you have created a panel of the commands you commonly 

use?  I know I couldn’t. 

 
4. Palette – Palette is a logical grouping of sub-palettes that house all the tools for creating and 

modifying objects.  Using the Palette is ideal for new users because the buttons cannot be 

removed and gives users a reliable location to access the commands as they are learning.  

(Shown Rotated 90° CCW) 

   

5. Work Area – The modeling window can consist of one or many windows showing different views 

of your design.  One scenario could include top view, front view, side view, iso view.  Because I 

use nothing but a laptop where “real-estate” space is limited, I choose to use just one window 

where I manipulate the view as needed.   
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6. Prompt Line – Just like Inventor (Lower left of screen) and AutoCAD (Command Line) Alias 

provides information that aids in the design process.  The prompt line will provide you with 

instructions on things such as, command feedback, error messages, numeric feedback, and 

information manually type in.  If the information goes by to fast, click on the small button to the 

left of the prompt line to view the history. 

 
7. Control Panel – This consist of a whole host of things.  There are three variations of the control 

panel, Modeling, Paint, and Visualization.  For the Modeling control panel there are display 

options for multiple object types, shelves to customize with our favorite commands, 

transparency settings, and editable fields to alter selected objects and so on.  Please explore the 

Visualization and Paint control panels to see the other variations.  (Shown Rotated 90° CCW) 

 
8. Marking Menus – Are gesture based menus that allow for quick access to many common 

commands.  They are accessible by holding the Shift + Ctrl and one of the mouse buttons (left, 

middle, right).  Left = pick options, Middle = manipulation options, Right = UI options.  These are 

fully customizable, but I would learn the defaults before modifying the originals.  Try screen 
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capturing all 3 and printing them out to have as a reference when using Alias Design.  This 

should get you up to speed in no time.  (See section below “Alias Mouse Shortcuts” item 2) 

 

Alias Hot Keys and How to Set Them 

Some users may choose to use hot keys, so to see what they are or to customize them to meet your 

specific needs go to. 

1.  Preferences > Interface > Hotkeys / Menu Editor 

Alias Mouse Shortcuts 

Below you will find the shortcuts for navigation, marking menus, snapping, and moving objects. 

1. Navigation 

a.  
 

2. Marking Menus 

a.  
 

3. Snapping – Point Snap 

a.  
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4. Snapping – Grid Snap 

a.  
 

5. Snapping – Curve Snap 

a.  
 

6. Orthographic Views 

a.  
 

7. Perspective Views 

a.    

Go On Now……Get That File! 

Since the Inventor model is currently residing in the Vault, we need to get a copy of it onto our local 

workspace.  We do this by logging into the Vault Explorer (Same credentials as if you were signing in 

through Inventor.) and performing a “Get” on the necessary file(s).  Once we have the files(s) locally we 

can then switch over to Alias Design.  Alias Design 2013 is the initial release where Vault is intergraded 

into the program, this will be a new concept for existing Alias users.  I highly recommend considering 

making Vault part of your day to day workflow whether you are using Inventor and Alias or just Alias.  

Remember, Vault is your single source of truth.  Here is how to log in from Alias Design. 

1. File Menu > Vault Server > Log In. 
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a. Once the Vault Log In dialog box appears sign in with your Vault credentials (Same 

credentials as if you were signing in through Inventor.) 

b. Select the “Automatically log in next time session” option to save some picks and clicks 

in the future. 

 

Here are two ways of how to import an Inventor file into Alias. 

1. Simply import the Inventor file into Alias 

a. File Menu > Import > File 

b. File Menu > Open 

2. Reference Manager 

a. File Menu > Reference Manager 

i. Reference in a .wref file.  This will give the user the ability to load and unload 

only the reference files necessary to keep file size down.  In order to use a .wref 

file the Inventor file must first be translated into the .wref file through the 

reference manager.   

1. Reference Manager > File > Translate 

2. Translate controls the quality of the model going into Alias 

3. After the file is translated into the .wref file, the .wref file is placed in 

the folder called “reference” within the project location. 

ii. Reference Manager > File > Import from Vault. 

1. A .wref must have already been checked into the vault 

iii. Reference Manager > File > Import  
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1. This will look in the “reference” folder for files that have already been 

translated. 

iv. To be able to “use” the imported .wref file in Alias 

1. Promote the required files to convert into surfaces. 

a. Must use the “pick-reference” to select geometry 

b. Both curves and Surfaces can be promoted.  Surfaces become a 

“stitched shell” which has to be “unstitched” to “use” the 

individual surfaces.  

c. Once a reference is no longer needed simply right click on it in 

the reference manager and “remove file”. 

 

 

I Went and Got the File, Now What? 

Since we are already cramming a ton of information into an hour and a half lecture, we will only be 

focusing on a couple commands to get us started.  There is a wealth of possibilities within Alias so; I 

highly recommend getting training to dive down deeper in the weeds. 
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Based upon the results of a survey I just fabricated, statistically the most used command would be the 

curve command.  Before we can effectively create curves in Alias Design, we must first have a basic 

understanding of a curve.  Without this understanding, using Alias can become frustrating and you will 

eventually close the program down.  Once we understand the physical makeup of a curve, we will look 

at the 2 main types of curves used in Alias (CV Curves and Edit Point Curves).  We are going to need both 

halves of our brain to get started; the right for creativity and the left for analytical thinking. 

I’m Scared and Don’t Understand 

Well then, let’s try and clear things up.  Some key definitions (you must know) with examples. 

Control vertex (CV) - Controls the shape of a curve or surface. They are the most basic means for 

controlling the shape of a curve. Lines between consecutive CVs are called hulls.  (Moving one CV will 

only move that CV leaving the connecting CV’s stationary producing a predictable result.) 

Curve - A connected sequence of straight or curved lines. 

Degree - A mathematical property of a curve or of a surface dimension that controls how many CVs are 

available for modeling. The default in Alias is degree 3, which has four CVs. The degree of your curves 

can affect data transfer to CAD packages.  Some other packages cannot accept curves with degree 

higher than 3.  Surfaces can have different degrees across their width and length. 

Edit Point - The point on a curve where consecutive curve segments are joined (Each “segment” is called 

a “Span”).  Although you can pick and move “edit points”, this is NOT generally considered good 

practice. (Moving one edit point will cause others to move erratically causing unpredictable results.)  

Hull - A line joining adjacent CVs, or a complete series of lines joining all CVs on a curve, or an entire row 

or column of CVs on a surface. 
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CV Curve 

Once the CV curve command is active you click where the CVs are to be placed.  

Remember the default is going to create a 4 CV 3 degree curve (You will need to click 

4 times to place the curve.  One click for every CV placed.).  To change the number of 

degrees (And the amount of CVs.) before you 

start the command, first 

double click the button (CV 

CRV) to activate the 

options for the command 

and change to suit your 

needs.  As a rule of thumb, 

it is best when creating 

curves to use the lowest 

amount of degrees while 

still achieving your design 

intent.  Let’s say you take 

that advice and start out with a 4 CV 3 degree curve.  Soon after you realize that you are wishing you 

used a 5 degree curve because you just cannot achieve the results you want with a 3 degree curve.  Well 

then you are in luck!  Changing the degrees can be done easily after the fact.  Simply select the curve 

you are wishing to change and within the Control Panel change the degrees to your desired quantity.  

You will notice that the number of spans is also listed.  Changing it to anything higher than one will 
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cause the curve to be divided up into multiple segments.  Again, a good rule of thumb is to keep that 

number as low as possible while still meeting the design requirements.  

Edit Point Curve 

To activate the Edit Point Curve command, left click and hold down the “CV CRV” 

button to get the fly out and release on the “EP CRV” button.  Using this command is 

completely different then the CV curve command 

in regards to its creation.  As you can see, the 

number of degrees that the command defaults to 

is the same as it was for the CV curve command.  

Repeat the same steps from above to change the 

starting degree if desired.  The first click when 

placing this curve is going to be the start of the 

curve.  The second point you select is going to be 

where you want to curve to end.  Basically, the 

fastest way from point “A” to point “B” is a 

straight line.  And that is exactly what is created.  

Except, it has all of the characteristics of a curve 

created using the CV curve command, it’s just a straight curve.  (Doesn’t sound right but, it is.)  You 

would then use a combination of “Pick” 

and “Transform” tools to move and 

position the “middle” CVs to their 

desired locations.  

Multi-Surface Draft (msdrft) 

 This command will allow the user to create a group of surfaces by pulling 

either surface curves or curves at an angle normal to its 

defining surface or curve.  There are many options within 

this command to tweak, so please explore this command 

further to understand its full capability.  Below are some 

examples of what is possible with msdrft. 
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1. Surface Edges – Before and after examples. 

 

 

2. Curves – Before and after examples. 

 
3. Iso-Parametric Curves – Before and after examples. 
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4. Curves on Surfaces (COS) – Before and after examples. 

 

Project 

This will allow you to project a curve onto a surface 

which will create a Curve on Surface (COS).  You have 

complete control over how the curve is projected.  For 

example, projecting in the X, Y, Z, current view state, 

normal, user defined vector.  Be careful if you are 

looking at the model in the perspective view instead of 

the orthographic view.  A curve will be projected using 

the perspective view and may give unwanted results.  

So, a good rule of thumb, try and set the view so that you are looking normal to the surface or use the 

project options to specify the vector. 

 

1. Project – Before and after examples. 
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Trim 

  Does exactly what you would expect it to do.  It 

trims the surface where you tell it to.  Well 

actually it “hides” the surface so if you ever need 

to, you can select the “Untrim” command and 

bring the trimmed surfaces back to life.  Once the 

surface has a curve projected onto it (COS).  

Simply select the surface to be trimmed and then 

decide whether you want to keep or discard the chosen area.   

1. Trim – Before and after examples. 

 

Surface Fillet (srfillet) 

To fully explore this command in its entirety would take 

hours because of its versatility and complexity.  So what 

we will do is, go over some basics and something’s that 

were challenging for me to learn transitioning from 

Inventor.  Before we start adding surface fillets, I 

recommend double clicking on the command to activate 

the options.  This will allow you to make changes after 

selecting the surfaces for filleting.  We can then update 

the model to view the results.  After selecting one set of 

surfaces, hit the space bar to continue the command to 

select the second set of surfaces.  Another important 

thing I learned, is that the surfaces that extend beyond 

the corner to be filleted are sometimes necessary in the 

fillet calculation process.  Remember, the surface fillet command can trim the extended surfaces 
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automatically, so trimming the surfaces prior to filleting may be adding an extra step.  We will be 

focusing on the construction type “Radius” which is the closest to the fillet command in Inventor.  The 

two types of sections I want to go over are G1 and G2. 

1. G1 Circular – Creates a fillet that will maintain a tangent continuity on both sides (Just like 

Inventor).   

2. G2 Curvature – Creates a fillet that as it blends into the existing surfaces the intensity of the 

fillet adjusts so that there is a smoother transition (You probably would not want to give this to 

the sheet metal shop). 

A few other things: 

1. Flow Control – Controls the relationship between the edges of the fillet and the surfaces. 

2. Form Control – Controls the shape of the fillet being created. 

3. Auto Update – Updates the model as you make changes in the options dialog. 

4. Curvature Comb – Displays a comb plot across the surface.  

5. Continuity Check – Shows if the edges sharing the newly created fillet maintain continuity.  

Depending on what options are selected some things may not be available because they are being 

driven by other settings.  Practice, practice, practice! 

1. Surface Fillet – Before and after examples. 

 

And we haven’t even scratched the surface yet (pun intended). 

There are still many things that can/should be included in this procedure.  I am talking specifically to the 

new users of Alias Design. Things such as, 

1. Surface continuity. 

2. How to pick specific entities. 

3. How to manipulate objects. 

4. How to change values that are already set. 

5. Alias folder structure. 
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Basically, don’t stop with this paper.  Keep learning and practicing and it will pay off in the end.  

Check it in and spread the word! 

Once we are finished with our model and need to share it with the Inventor community we need to 

check it into the Vault.  Keep in mind, only the layers that are visible when saved will come across to 

Inventor. Check in files by going to: 

1. File Menu > Vault Server > Check In 

a. If you are working in a shared workspace, you do not want to “Close files and delete 

working copies”.  Try and always select “Create visualization attachment” this will create 

a “.dwf” file within the vault which is helpful when searching for a particular file. 

 

Bring Alias concepts into Inventor for final touches 

And now I feel comfortable again.   

Once Again, we need to use Vault Explorer and “Get” the Alias Design wire file to our workspace.  Once 

the “.wire” file is local, there are a couple ways of bringing it into Inventor.  One method isn’t necessarily 

better than the other it is more of a user preference.  Here are those methods within Inventor: 

1. Place component 

a. Change the file type to “Alias Files (.wire)” 
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b. No matter what file type is being brought into Inventor, dont go to fast and just double 

click the file and are stuck with whatever shows up in Inventor.  Don’t do that!  Simply 

click on the file ONE time and you will notice that the button “Options” will become 

illuminated.  Click on it!  Even if you decide not to make any changes at least you know 

how the file is being translated.  Therefore if you do not like the results, you can go back 

and try it again.  We will get to what’s in the “Options” dialog box in a minute. 

2. Start a new part > Manage Tab > Insert Panel > Import command 

a. This method allows you to select a specific template beforehand, which will serve as a 

container for which you import in the Alias file.  Again we get the dialog box to select 

the “Options” button.  

 

3. Open File 

a. Again change the file type to “Alias Files (.wire)” and click on the file ONE time. 

 

Now we will take a look at the “Options” button and the two options for bringing in the .wire file. 

1. Associative Import (Recommended) 

a. Preforms exactly as expected.  If the .wire file is updated with in Alias Design then the 

updates will come across to Inventor. 
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b. As the .wire file is updated within Alias Design you bring across the changes by going to 

the Manage Tab > Update Panel > Rebuild All (You may want to add the Rebuild All 

button into the marking menu for quick access.)  

 

c. At any time you can right click on the .wire file in the browser and “Edit Derived Alias” 

which allows you to add or remove objects from the Alias Design file. 

2. Non-Associative Import 

a. What you see is what you get, nothing more and nothing less.  If you do not want/need 

updates from Alias Design then this is for you.  The rest of the dialog box becomes 

illuminated much like if you were bringing in a .step, .iges file.  Again, the first shot at 

bringing in the Alias Design file may not produce the best results.  Play around with the 

settings to achieve the best result. 
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Develop the model as required using Inventors full potential.  Now let’s take a look at the Alias side of 

things again and modify the .wire file and see how it updates within Inventor. 

Work back and forth in Inventor and Alias to achieve desired results 

Check Out That File…..Part Deux 

You know the drill: 

1. From Alias Design open the .wire file from Vault. 
2. Make the desired changes. 
3. Save and check in the file. (Don’t forget to “Create Visualization Attachment.) 

Back in Inventor 

open the .ipt file 

created from 

the .wire file.  

You should 

notice that there 

is a red lightning 

bolt next to the 

.wire file.  This means a change has happened 

and you need to “Update” the Inventor file to bring forth the changes.  If 

the changes are significant enough that Inventor doesn’t know how to 

handle them, then, you will see the yellow warning sign next to the .wire 

node in the browser, it means that there is a conflict between the Alias and Inventor file.   To correct it 

right mouse click on the node and select “Update Associations”.  Fix as necessary.  Continue the back 

and forth workflow between Alias Design and Inventor until the job is complete.  This should be enough 

to get you up and running working between the two pieces of software.  Have fun and be creative 

because with these two software packages anything is possible.   

Thank you and good night. 

I hope this paper finds you well.  For a mechanical person to put on the hat of a digital sculptor, can and 

is a daunting task.  Don’t give up, the more time and effort you put into learning Alias the sooner you 

will be on your way.  I can’t stress enough how important training will be during this transition process.  

Until we meet again, cheers! 


